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Overview
* Machine learning for Pixel and Object Classification
 Random Forest Classifiers

* Python
* scikit-learn / napari
* Accelerated pixel and object classification (APOC)
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* Recap: Finding the right workflow towards a good segmentation takes time

) Image data source: BBBC0O38v1, available from the Broad Bioimage Benchmark
, @haesleinhuepf June 2023 Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
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e Recap: Combining images, e.g. using Difference of Gaussian (DoG)

) Image data source: BBBC0O38v1, available from the Broad Bioimage Benchmark
, @haesleinhuepf June 2023 Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
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* Might there be a technology for optimization which combination of images can be used to get the best
segmentation result?

) Image data source: BBBC0O38v1, available from the Broad Bioimage Benchmark
, @haesleinhuepf June 2023 Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
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* Aresearch field in computer science
Trainable Weka Segmentation
https://imagej.net/plugins/tws/

Artificial intelligence

LabKit
https://imagej.net/
plugins/labkit/

Machine learning

Python /
scikit-learn /
napari /
apoc

) Image data source: BBBC0O38v1, available from the Broad Bioimage Benchmark
, @haesleinhuepf June 2023 Collection (Caicedo et al., Nature Methods, 2019].


https://imagej.net/plugins/labkit/
https://imagej.net/plugins/labkit/
https://imagej.net/plugins/tws/
https://bbbc.broadinstitute.org/BBBC038

Machine learning

* Aresearch field in computer science

* Finds more and more applications, also in life sciences.

Artificial intelligence

Machine learning e

https://github.com/stardist/stardist
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Biolmage Model Zoo
Advanced Al models in one-click

Integrate with Fiji, llastik, ImJoy and more
Try model instantly with BioEngine
Contribute your models via Github
Link models to datasets and applications

&7 Explore the Zoo

Community Partners

AH T |

#ZeroCs

All models applications datasets

Type a keyword and press enter | Tags & Filters «

@ Mitochondria Segmentation for EM

Mitochondria segmentation for electron microscopy.

3d electron-microscopy  mitochondria  instance-segmentation . -

https://bioimage.io/

Logos and screenshots are taken from the github repositories / websites
YW @haesleinhuepf June 2023 provided under BSD and MIT licenses.


https://github.com/stardist/stardist
http://www.cellpose.org/
https://bioimage.io/
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* Automatic construction of predictive models from given data

Pixels, Objects, Images, Audio, Text, Measurements, ...
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Instance segmentation Cont. quantity / regression eca
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PMicroscope: 0.4
Height =80 cm

HENEEEER
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Goal

* Guess classification (color) from position of a sample in parameter space.

Input data

YW @haesleinhuepf

Linear SWVM

Decision Tree

PolL
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Random Forest

Adapted from https://scikit-learn.org/stable/auto _examples/classification/plot classifier comparison.html

June 2023

© 2007 - 2019, scikit-learn developers (BSD License).


https://scikit-learn.org/stable/auto_examples/classification/plot_classifier_comparison.html
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* The right approach depends on data, computational resources and desired quality

Input data Nearest Neighbors Linear SVM RBF SVM Gaussian Process Decision Tree Random Forest Neural Net AdaBoost Naive Bayes QDA

Adapted from https://scikit-learn.org/stable/auto _examples/classification/plot classifier comparison.html
’ @haesleinhuepf June 2023 © 2007 - 2019, scikit-learn developers (BSD License).



https://scikit-learn.org/stable/auto_examples/classification/plot_classifier_comparison.html
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* Supervised machine learning: We give the computer some ground truth to learn from

 The computer derives a model or a classifier which can judge if a pixel should be foreground (white) or
background (black)

 Example: Binary classifier

Training

P

Model /

classifier

Raw image Binary image

YW @haesleinhuepf June 2023



Random forest based image segmentation p PoL
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* Decision trees are classifiers, they decide if a pixel should be white or black

 Random decision trees are randomly initialized, afterwards evaluated and selected

 Random forests consist of many random decision trees

 Example: Random forest of binary decision trees

No

June 2023 T

YW @haesleinhuepf T
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* For efficient processing, we randomly sample our data set
* Individual pixels, their intensity and their classification
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Note: You cannot use a single threshold to make the decision correctly

YW @haesleinhuepf June 2023
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* Decision trees combine several
thresholds on several parameters

R - i
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* Depending on sampling, the
decision trees are different
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* By comparing performance of individual decision trees, good ones can be selected, bad ones excluded.

Selection

Sampling T

YW @haesleinhuepf June 2023

Imagedatasourcer BBBCO38vt; avaitabte fromtheBroad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038

Segmentation quality estimation PoL
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1
@ Prediction A

< v Reference B
*._-~ (ground truth)

* In general

* Define what’s positive
and what’s negative.

 Compare with a
reference to figure out
what was true and false

| . :
| ROI'I Region of interest

—
‘ True-positive

FN False-negative

‘ False-positive
d

TN True-negative

 Welcome to the
Theory of Sets

Overlap TP
(a.k.a. Jaccard index) TP+ FN + FP

How much do A and B overlap?

TP

Precision —_—— What fraction of points that were predicted as positives were really positive?
TP+ FP
TP
(a.k.al.qggﬁlslzitivity) TP+ EN What fraction of positives points were predicted as positives?

Y @haesleinhuepf June 2023
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* By comparing performance of individual decision trees, good ones can be selected, bad ones excluded.

Selection

Sampling T

YW @haesleinhuepf June 2023

Imagedatasourcer BBBCO38vt; avaitabte fromtheBroad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038

Random Forest Pixel Classifiers

* Combination of individual tree decisions by voting or max / mean

Prediction

m—)

® <
*

1

Y
® @ O ) @

YW @haesleinhuepf
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* Typical numbers for pixel classifiers in microscopy

Available features: > 20

OOOO Gaus.sian blur image t ?
O <><> O . ?(;)(?ilrrr]\qaaggee - Depth: 4
O<> Hessian ?

Selected features: <= depth

Number of trees: > 100

280 Hratle ot s

YW @haesleinhuepf June 2023
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* A good classifier is trained on a hand full of datasets and works on thousands similarly well.

* In order to assess that, we split the ground truth into two set
* Training set (50%-90% of the available data)
* Test set (10%-50% of the available data)

Classifier

Ability to

/ abstract

Training set

Ground truth Prediction

Prediction

Test set

¥ @haesleinhuepf Raw data June 2023 Prediction Ground truth

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
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Train dataset (e.g. 80% of the data)
* Used for training directly U nderfitting

Validation dataset (10% of the data) | \

» After every iteration see if the model overfits —
Q
=
Test dataset (10% of the data) g
* Final evaluation after training is finished (once) AN Overﬁtting
.
Underfitting q;)
* A trained model that is not even able to properly O
process the data it was trained on —
Overfitting A
e A rrlmlodel that is able to process data it was trained on 8
we
* |t processes other data poorly Training duration

https://towardsdatascience.com/how-to-split-data-into-three-sets-train-validation-and-test-and-why-e50d22d3e54c

YW @haesleinhuepf June 2023


https://towardsdatascience.com/how-to-split-data-into-three-sets-train-validation-and-test-and-why-e50d22d3e54c
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 What if we exchange pixel features with object features?

Pixel classification Object classification
O O
- O O
L
§ o0 ® ® (g) > o ® (g)
c £ =
‘ 5% 0. [ O 5 0. ® O
g’% © o O Sl e e 4 ®
- =
° o @ ° O K

Intensity Aspect ratio

* The algorithms work the same but with different
* Features
 Number of features
* Tree / forest parameters
* Selection criteria

— i
YW @haesleinhuepf June 2023



Unsupervised machine learning PoL
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 If you don’t provide ground truth, the algorithm is unsupervised.

5 O

. O
2| o O O .
2 o, o @
5 O
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= O o o °

O O

frequency Aspect ratio

ot

frequency
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* If you don’t provide ground truth, the algorithm is unsupervised.

* Nevertheless, algorithms can tell us something about the data

4 Round Elongated
@)
@,
2| L © e ©
2O O
g O ©
= o 0 g
& O O
O @)
O o
frequency Aspect ratio

I i
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Feature extraction

Robert Haase

With material from
Johannes Soltwedel, BiaPolL, PoL TU Dresden

Marcelo Zoccoler, BiaPol, PoL, TU Dresden

June 2023 These slides can be reused under the
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* A feature is a countable or measurable property of an image or object.

* Goal of feature extraction is finding a minimal set of features to describe an object well enough to
differentiate it from other objects.

* Intensity based * Shape based /spatial e Spatio-temporal e Others
* Mean intensity e Area/Volume e Displacement, e Overlap
e Standard deviation * Roundness e Speed, * Colocalization
e Total intensity e Solidity * Acceleration e Neighborhood
* Textures  Circularity / Sphericity
* Elongation
e Centroid

* Bounding box

* Mixed features
* Center of mass
e Local minima / maxima

YW @haesleinhuepf June 2023
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* Length of the outline around an object

* Depends on the actual implementation

0 0
1 1
2 2
3 3
4 4
y’ y'

W @haesleinhuepf June 2023
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* For every object, find the
optimal ellipse simplifying
the object.

* Major axis ... long diameter

e Minor axis ... short diameter

* Major and minor axis are
perpendicular to each other

YW @haesleinhuepf June 2023
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* The aspect ratio describes the elongation of an object.

AR = major / minor

Y @haesleinhuepf June 2023
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* By removing all concave corners of an object, we retrieve its convex hull.

YW @haesleinhuepf June 2023
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* By removing all concave corners of an object, we retrieve its convex hull.

NN

YW @haesleinhuepf June 2023
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* By removing all concave corners of an object, we retrieve its convex hull.

NN

YW @haesleinhuepf June 2023
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* By removing all concave corners of an object, we retrieve its convex hull.

r—

solidity =

AconvexHull

YW @haesleinhuepf June 2023



Roundness and circularity

* The definition of a circle leads usto ~ Dlameter
measurements of circularity and
roundness. Circumference

* |n case you use these measures,
define them correctly. They are not Area
standardized!

4 x A
roundness = —
T major
Roundness =1
AT % A Circularity =1
circularity = . >
perimeter

YW @haesleinhuepf

June 2023

d

C =mnd
A_nd2
4

Roundness = 1
Circularity = 1

PolL

TU Dresden

O EEEEEEEEEEEEEEE S

Roundness < 1

Physics of Life o —~4
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! napari

File View Window Plugins Tools Help

* Draw representative

shapes and study o .o
measurements 2XAdL O 2O image blobs (data)

labels Labels (data)
label: 3 +

opaciy: 0.70

brush size: 3

size
intensity

perimeter

blending: translucent
shape

color mode:  auto position

contour:; moments
n edit dim:
contiguous:

preserve
lahels:
show

selected: . aspect_ratic roundness circularity

1 1.0 1.0000954543330893 0.943640%933949713

Copy to dipboard Save as csv...

2 1.0253623128080016  0.8173510558916977 0.16224252119413082

| abels 3 1.9214434103378378  0.5185116548813216 0.7967426370681985

blobs

i )

use = 1= for activate the label eraser, use <2> for activate the paint brush, use <3> for activate the fill bucket, use <4= for pick mode ~ activity

YW @haesleinhuepf June 2023
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@& Feature extraction in napari - For X + - n = =
€ > C @& focalplane.biclogists.com/2023/05/03/feature-extraction-in-napari/ G @ = %+ #» 0O e
@& Feature extraction in napari - For X + - n = =
The (,ompfuw of
BIO Oglsts €& - C & focalplanebiologists.com/2 ature-extraction-in-napari/ G & 2 & %» 0O e
3 w = O s
_ Home Aboutus Topics Gallery Jobs Events [ttt il
A‘ « > C @ focalplane.biologists.com/2 /03 /feature-extraction-in-napari/ G @ =2 2w ¥ 0O e

Contactus Login/register Q

W

&

Home Aboutus Topics Gallery Jobs Events Resources Network

LY dllo evels and e ' dalt ohe heed

*FocalPlane )

Where biology meets microscopy | | "
i h\/\ Categories of features Contactus Login/register Q

We can differentiate features into different categories:
Events

Home Aboutus Topics Gallery Jobs Glossary

Feature categories This is a collection of features provided by napari-skimage-regionprops (nsr} and napari-simpleitk-image-
Contactus Login/register Q , - P o - 3, o [ , [ )
processing (n-Simplel TK). Hereby, note that some of the mentioned parameters may be implemented
differently in both libraries.

Home / Blog series / Bio-image Analysis with Napari /

cat impl
feat schemati lanati p . eme
Feature extraction in napari x eature = €g  explanation ormuia iy
ory
Posted by Mara Lampert, on 3 May 2023 o
This bleg post revolves around extracting and selecting features from size intensity shape position
the terms feature extraction and selection. Also, we will learn how to cd oh - .
chematic of different feature categories area (or volume - sixels/ v S i -1 X pizelarea
specific features in a glossary. Furthermore, we will explore how to extr 9 area (or volume A _— sum of pixels/ voxels of the region Area = T pixels X pixel .
. . Size (siz)-based parameters relate to magnitude or number of dimensi in 3D) scaled by pixel-area/ voxel-volume. otume = Evaxels X pavel area
Definition of feature extraction
Intensity (int)-based parameters are all parameters related to the po
During feature extraction, quantitative measurements are assig Examples are minimum, mean, maximum intensity.
image regions. Feature type involves both feature detection and f} Shape (sh) -based parameters refer to the geometry of the object and =the ratio
description. Importantly, features should be independent and surface. Examples are roundness, aspect ratio and solidity. aspect_ratio sh  between object width Arpec rotta w TTEITIR |
of location, rotation, spatial scale or illumination levels (Gonzalez and object length.
Position (po)-based parameters refer to where an object is at a particul
frame of reference.
; = mini i i idth = (x2 — x1,
Moment (mom)-based parameters refer to a physical quantity which h bbox po d.mlnlm.um range in each spatial :::igth =((§,2 _3;1)) ner
reference point. Hereby, the moment relates to the location or arrange Imension depth = (22 — 21)
bbox_area (or _ 1 = number of pixels/ voxels of bounding a

https://focalplane.biologists.com/2023/05/03/feature-extraction-in-nagari/ = st poxscaledby phelareal voxel

YW @haesleinhuepf June 2023
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Pixel classification
using scikit-learn

Robert Haase

. June 2023 The scikit-learn logo is BSD3 licensed by the scikit-learn developers
’ @haesleinhuepf https://commons.wikimedia.org/wiki/File:Scikit learn logo small.svg



https://commons.wikimedia.org/wiki/File:Scikit_learn_logo_small.svg
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 Classify objects starting from feature vectors (table columns)

Raw data “Ground truth” annotation Classifier training

area elongation annotation = [1, 1, 2, 1, 1, 1, 2, 2,
3950088 2.8435432 . . . .
rossors 5250008 classifier = RandomForestClassifier()
7469852 5575289 classifier.fit(train_data, train_annotation)

2.544467 3.017479
3.465662 1.463756
3.156507 3.232181

Classifier prediction

6.001683 5.047063

2457138 3.416050 result = classifier.predict(validation data)

3.672295 3.407462

W O0e o~ @ nm kW M = O

10 9.413702 7.598608

12 A 12 12 -

., :
. @ ']
. 10 [
10 10 ....' o" ==
. ] \
. 5 e 5 . [ 1) * . .
™ <
E = E ' h “
=] 8 o . 3 . "o
w B B G B 6 '.’.
=Y o - E" L ] L™ L
& s . 2 L] ¢
2 T o 4 .
4 4
2 2 2
n ﬁ n T T T T T T T
0 2 4 B 8 10 12 0 2 4 6 8 10 12 o 2 4 6 8 10 12
area area area

y @haesleinhuepf https://github.com/BiAPolL/Bio-image Analysis with Python/blob/main/09 machine learning/01 supervised machine learning.ipynb



https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/01_supervised_machine_learning.ipynb
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* Prepare an empty layer for annotations and keep a|reference

np.zeros (image.shape) .astype (int))

e Read annotations

manual_annotations = labels.data

from skimage.i10 import imshow
imshow (manual annotations,

vmin=0, vmax=2)

YW @haesleinhuepf

labels |= viewer.add labels(

175

50
150

100 125

100

150
075

050

hold <space> to pan/zoom, hold <shift> to toggle preserve labels, hold <control> to fill, hold <alt> to erase, drag to paint a label

200
025

0.00
o 50 100 150 200 250 a0

https://github.com/BiAPoL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb

Interactive pixel classification PolL
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* Pixel classification using scikit-learn

* Expects one-dimensional arrays for
* every feature individually
e ground truth

# train classifier

from sklearn.ensemble import RandomForestClassifier

classifier = RandomForestClassifier (max depth=2, random state=0) Image data
classifier.fit (X, V) . —
—— = — y = classifier.predict (X)
Ground truth /

annotation

Image data

prediction

’ @haesleinhuepf https://github.com/BiAPoL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb



https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb

Interactive pixel classification CP PoL
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* Pixel classification using scikit-learn

s, 2019].

 Expects one-dimensional arrays for
e every feature individually
e ground truth

# for training, we need to generate features

100 200

lat NMeth e
Natuarcivicunou

F| P T N
Caritcaocial,1

(C

feature stack = generate feature stack(image)

X, y = format data(feature stack, manual annotations)

# train classifier
from sklearn.ensemble import RandomForestClassifier
classifier = RandomForestClassifier (max depth=2, random state=0)

classifier.fit (X, vy)

47
, @haesleinhuepf https://github.com/BiAPolL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Coltection-{


https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb

Interactive pixel classification PoL

* Pixel classification using scikit-learn

# process the whole image and show result
result 1d =
result 2d =

viewer.add labels (result 2d)

YW @haesleinhuepf
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2L L Q
label: 1
opacity:
brush siz
blending:  transiucent
color mor  aute
contour: 0
n edit din
contiguot +

preserve | els: show sel

SN

classifier.predict (feature stack.T)
L
result 1d.reshape (image.shape) e image

> O oo i

result_2d [-6 98] enter paint or fill mede to edit labels

43
https://github.com/BiAPoL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb

BBBCO038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].

Image data source:


https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb
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e Jupyter notebooks and napari side-by-side
— O 4
scikit_learn_random_forest_pixel X =+ ﬂ
« =-> C @ localhost:8889/notebooks/machine_ earning,/sc kii_|EEI"'I_I’EIr'lIZ|C—I'I'I_fDI'ESi_|3i.‘<ZE|_C|F; a Y% ﬂ :
napari - m} X

v Plugine  Help

Jupyter scikit_learn_random_forest_pixel_classifier (autszaves)

File Edit View nsert Cell Kermel Widgets Help AL 2 Q
label: = 1 +
E 4+ ||| 4 4 [ rRun | B|3| k| code w | | = opacky:
brush siz
H - blending:  translucent
Interactive segmentation -
. . . . . . i contour:  — 0 +
We can also use napari to annotate some regions as negative (label = 1) and positive (label = 2). nedit dn — 2

contiguot

In [2@]: M import napari preserve | zls: show sel

# start nopari

viewer = napari.viewer()

# gdd image

viewer.add _image(image)

# gdd an empiy Labels laver and keet it in o variable W . .

labels = viewer.add_labels{np.zercs{image.shape).astype{int}) " E 3
=

Go ahead after annofating af least fwo regions with labels 1 and 2. '-.r ﬁ

. - B
Take a screenshot of the annotation: ' ‘: _.'- ‘_L

-
a

> 6 9o

Labels [-6 -7] enter paint or fill mode to edit labels

, @haesleinhuepf https://github.com/BiAPolL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb

Interactive pixel classification ) PolL
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e Jupyter notebooks and napari side-by-side

! napari

File View Window

x @

- XA L L Q

label: = 2 +

scikit_learn_random_forest_pixe! X - °

& > C @ localhost:8889/notebooks/machine_learning/scikit_learn_random_forest_pixel_clas... & opacky:
brush siz
~Jupyter scikit_learn_random_forest_pixel_classifier (unsaved cnanges) (o] Dendng: ekt

color mor  auto

File Edit View nsert Ce Kernel Widgets Help Truste contour: (=0
nedtdn - 2
B+ B 4| | PRun B C| MW | Makdown v | = contiguot ¥

preserve | zls: show sel
In [58]: M napari.utils.nbscreenshot(viewer)

XA L 2 Labels

Labed 2 image
opacty

brush so @ - g ’ .
L
blendng: o cmnyt . '
CoOr Mo -
contour : r ﬁ -l b

nedt dn - i ‘ C1 i

ahg> W
L]

presesve | vs thow sod

&

>~ B eoiif

Labels [ -6 109] hold <space> to pan/zoom, hold <shift> to toggle preserve_labels, hold <control> to fill, hold <alt= to erase, drag to paint a label

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].

, @haesleinhuepf https://github.com/BiAPolL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn random forest pixel classifier.ipynb



https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb

Interactive pixel classification

e Jupyter notebooks and napari side-by-side

scikit_learn_random_forest_pixel X =+

Jupyter scikit_learn_random_forest_pixel_classifier (autsaves)
File Edit View nsert Cell Hemel Widgets Help

B+ | & B || FRun | B C| M | Makdown v | | =

# train clossifier
classifier = RandomForestClassifier(max_depth=2, random_state=a}
classifier.fit(x, ¥)

# process the whole imoge and show result
result_i1d = classifier.predict{feature_stack.T)
result_2d = resuli_id.reshape(image.shape)
imshow{result_2ad)

PolL

Physics of Life
TU Dresden

label:

opacity:

brush siz

blending:  translicent

color mor  auto

In [52]: M # generate features (that's octually not nmecessary, contour: = 0
# as the variagble is still there and the imoge is the same. nedtdn = 2
# but we do it jFor completeness) contiguot v
feature_stack = generate_feature_stack{image) preserve | zls: Shonlisel
X, v = format_data{feature_stack, manual_annctations)

X

| N
result_2d
Labels

image

out[sz2]

matplotlib plugin.py (158): Low image data range; displaying image with stretc

<matplcotlib. image.AxesImage at @x244558eclies

imi;‘

YW @haesleinhuepf

> BHediif

Labels [0 01: 0

https://github.com/BiAPolL/Bio-image Analysis with Python/blob/main/09 machine learning/02 scikit learn

enter paint or fill mode to edit labels

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].

random forest pixel classifier.ipynb



https://bbbc.broadinstitute.org/BBBC038
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/02_scikit_learn_random_forest_pixel_classifier.ipynb
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Accelerated pixel and object
classification (APOC)

Robert Haase

October 2022
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Accelerated pixel and object classification PoL
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 APOC is a python library that makes use of OpenCL-compatible Graphics Cards to accelerate pixel and
object classification

50

100

150

200

50 100 150 200 250

Class label image

Object label image

0 0
50
100 100
150 150

200 200

50

Pixel annotation Object annotation
YW @haesleinhuepf June 2023
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Object segmentation PolL
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* Pixel classification + connected component labeling

Raw image

100

150

200

250
50 100 150 200 250

Pixel annotation
YW @haesleinhuepf

# define features
features = "gaussian _blur=1 gaussian_blur=5 sobel of gaussian blur=1"

# this is where the model will be saved
cl filename = 'my object segmenter.cl'’

# delete classifier in case the file exists already
apoc.erase classifier(cl_filename)

# train classifier
clf = apoc.ObjectSegmenter(opencl filename=cl filename, positive class identifier=2)
clf.train(features, manual_annotations, image) o ® W0 150 20 750

segmentation result = clf.predict(features=features, image=image) ObjeCt label image
cle.imshow(segmentation result, 1abels=Trueﬂ

Object segmentation

https://github.com/BiAPoL/Bio-image Analysis with Python/blob/main/09 machine learning/03 apoc object segmenter.ipynb



https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/03_apoc_object_segmenter.ipynb

Object classification PoL
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* Feature extraction + tabular classification

# for the classification we define size and shape as criteria
features = 'area mean_max_distance to centroid ratio’

100

150

# This 1s where the model will be saved

. cl filename object classifier = "my object classifier.cl”

50 100 150 200 250 oy - . .
# delete classifier in case the file exists already

Object label image apoc.erase classifier(cl filename object classifier)

# train the classifier
classifier = apoc.ObjectClassifier(cl filename object classifier)
classifier.train(features, segmentation result, annotation, image)

100

# determine object classification Class label IMmage

classification result = classifier.predict(segmentation result, image)
cle.imshow(classification result, labels=True)

150

200

0 50 100 150 200 250

Object annotation Obiject classification

, @haesleinhuepf https://github.com/BiAPoL/Bio-image Analysis with Python/blob/main/09 machine learning/03 apoc object segmenter.ipynb
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* Object segmentation

* https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification#object-and-semantic-
segmentation

X @

3o 2P AR - WP L OX
label: || 2 t
opacity:

brush siz

blending: translucent

color mor  auto

contour: 0

n edit din

COFItigLIOL - Training Application [ Prediction
preserve

labels: Select ground truth annotation / object label

S SR

Labels

Image:0

1sumption (GPU): 1.0 MBytes
Train

> B8 ed i

Labels [100 134]: 0 enter paint or fill mode to edit labels ~ activity

YW @haesleinhuepf June 2023


https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification#object-and-semantic-segmentation
https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification#object-and-semantic-segmentation

Supervised machine learning for tissue classification <=|'-'-'> PoL

TU Dresden

Random Forest
Classifiers based on

e scikit-learn and

* clesperanto

S SR

®
® Result of voronoi otsu lab...
@ Result of top hat box

*" @ Lund 18,0 22.0 Hours-resa...

I
) @haes|einhugtt?s://github.com/haesleinhuepf/napari—accelerated—pixel—and—ob]ect—classification TECHN'SCHE (ﬁ
L | ’ UNIVERSITAT DRESDEN

@PolDresden Image data source: Daniela Vorkel, Myers lab, MPI-CBG/CSBD DRESDEN concept B4



https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification

Data exploration / supervised machine learning PoL

TU Dresden

* Inspect how the random forest N ——

classifier makes decisions R ———— - | ; I —

label: = 1 + ; 1 labels Result of voronoi_otsu_labeling (desperanto) (data)
opacity: S s ‘ : ) annotation Labels (datz)

brush siz gt VA ) : . model filename__OhiactClassifier ol Select file

blending: translucent v P i pi Py ' max depth 3

* Note: Beware of correlated e, [E— F o F o
parameters! cdlr mo Rk

contour: t . 3 e v mean intensity
n edi din ¥ 44 : X __'-'.. ,. L . maximum intensity
H 2 . . 2 \ Y : sum intensity
Dock widget 1 b3 Bty Wi \ :
At TR . v standard deviation intensity

v pixel count

+" shape (extension ratio)

area centroid position

touching neighbor count
mea r1_i nten Slt_‘rf . average centroid distance of touching neighbors
v/ centroid distance to nearest neighbor
standa rd—d eviatio n—i nten S,It_".f + average centroid distance to 6 nearest neighbors
v/ average centroid distance to 10 nearest neighbors

mean_max_distance_to_centroid_ratio ¥ show dassifier statistics

average_distance_of_n_nearest_neighbors=1

average_distance_of_n_nearest_neighbors=6

average_distance_of_n_nearest_neighbors=10

enter paint or fill mode to edit labels “ activity

UNIVERSITAT DRESDEN
DRESDEN concept

@haesleinhu ://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification @ TECHN'SCHE

, @PolLDresden

Image data source: Daniela Vorkel, Myers lab, MPI-CBG/CSBD


https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification

Data exploration / supervised machine learning ) PoL |
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* Inspect how the random forest P r———

classifier makes decisions

w

Q / & , O\ = Feog . Image:0 (data)

label: _ 1 + v : labels Result of voronoi_otsu_labeling (desperanto) (data)
opacity: - - annotation  Labels (data)
brush sz T e A e model filename__OhiactClaccifiar A Select file

blending: translucent P P . max depth K

 Note: Beware of correlated e, E— £ S e
pa rameterS! color moi  auto ’ e, ! — =

contour: + - .= N iy '+ I +' mean intensity
n edit din + e .‘_:-'.‘.- L e maximum intensity
contiguot v : T ‘ s : sum intensity
IEIE\SENE - :“. be % . : L . \ ', ' standard deviation intensity
L - " pixel count
. +" shape (extension ratio)
D oc k wi I:I g et E centroid position

touching neighbor count

average centroid distance of touching neighbors

centroid distance to nearest neighbor

drea

+' average centroid distance to 6 nearest neighbors
- - | Je Bty average centroid distance to 10 nearest neighbors
rnean_intensity Yo Fooltusdy . .

" show dassifier statistics

standard_deviation_intensity
mean_max_distance_to_centroid_ratio

average_distance_of_n_nearest_neighbors=6  [U=3lL

enter paint or fill mode to edit labels  activity

@haesleinhu ://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification TECHN'SCHE
, PolLDresd UNIVERSITAT DRESDEN
@PolDresden Image data source: Daniela Vorkel, Myers lab, MPI-CBG/CSBD DRESDEN concept



https://github.com/haesleinhuepf/napari-accelerated-pixel-and-object-classification

Data exploratio NEe Yo e 0 |eg g ) P

) C @ C U O Olf=

o File View Window Plugins Tools Help
* Q t
- ) )
c C U @
opacity: ?
contrast imits: Y
auto-contrast: ~ once continuous NI I I3
gaiina. Remove Remove Filter
s i backgrou...
» colormap: B twh ¥ S
) ) ) ) )
O » C O O C U
blending: translucent ¥ = V- ® ey o
g >> ﬂ >>D l"_>>l’. l’_>>
)Adl ClLE interpolation: linear v
s Z Transform Projection Binarize Label
rendering: mip v
depiction: volume v 1 | g -
> Dt CIOLL SDul
~ Measure ) Compare
Process Measure
w Q labels labels |§be|ed vlabel
image images
v ‘ 0 (] o’ = o’
l XS XS S R
§: @ Resultof average ... & g |
2 neighbor Label filters Mesh Measure
£y @® Result of mean_ext... Gd filters
x =
§; ® Resultof standard... & x(y)
1 2 3 ® . =
Result of mean_int... . -
area H .
® Result of label_pix... G
X =« Q
mean_intensity @® Result of voronoi_... &
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. . . rar
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- A\ i
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Result of average_distance_of_n_closest_neighbor 4 activity
|
P g 0 O pera 0 dapd 9, espera O d d |1

Q
Q
D
D
D
(@)
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https://github.com/clEsperanto/napari_pyclesperanto_assistant
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Pixel classification / object segmentation ) PolL
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e Use Napari to segment objects

Click on Train . A label image should show up.
W neperi = o X

Interactive pixel classification and object segmentation in Napari

In this exercise we will train a Random Forest Classifier for pixel classification and convert the result in an instance segmentation. We will use

the napari plugin napari-accelerated-pixel-and-object-classification. A7 S o
Getting started
Open a terminal window and activate your conda environment: ' ke

@ i —

conda activate devbio-napari-env
Afterwards, start up Napari:
i

napari

Load the "Blobs" example dataset from the menu File > Open Sample > clEsperanto > Blobs (from Imagel)

If the segmentation works well, consider backing up the objectSegmenter.cl file that has been saved. If you didn't change the file location
before training, it will be located in the folder from where you started napari on the command line.

https://github.com/BiAPolL/Bio-
image Analysis with Python/blob/main/09 machine learning
/interactive pixel classification/readme.md

YW @haesleinhuepf June 2023


https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_pixel_classification/readme.md
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_pixel_classification/readme.md
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_pixel_classification/readme.md

Object classification PoL

Physics of Life
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e Use Napari to group round and elongated objects

Train the classifier again.

Interactive object classification in Napari = =5 x|

dow Plugins Tools Help

In this exercise we will train a Random Forest Classifiers for classifying segmented objects. We will use the napari plugin napari-accelerated-
. . e . x Q / & , Q biobs (data)
pixel-and-object-classification. - Ty DT el
label: 1
- s annotation Labe! dlass annotation (data)
. opacty: .
Getting started s 10 _

max depth
blending: transkcent v

Open a terminal window and activate your conda environment: color moi  auto -

contour: 0
E = 5 n edit dn 2

conda activate devbio-napari-env @

contiguot «

preserve
3 labels:
Afterwards, start up Napari:

- a

..‘0

napari @

® Train_object_classifi...

f touching neighbors
Load the "Blobs" example dataset from the menu File > Open Sample > clEsperanto > Blobs (from Imagel) ® Resultof Objectseg

We furthermore need a label image. You can create it using the pixel classifier trained earlier or using the menu Tools » Segmentation / = Labels
labeling » Gauss-Otsu Labeling (clesperanto) . D blobs

Object classification

Cur starting point is a lcaded image and a label image with segmented objects. The following procedure is also shown in this video. show feature corelation matrix

Run

W rapeii = [m x

hold <space> to pan/zoom, hold <shift> to toggle preserve_labels, hold <control> to fill, hold <alt> to erase, drag to paint a label ~ activity

If you are happy with the trained classifier, copy the file to a safe place. When training the next classifier this one might be overwritten.

label : Extra exercise

opacky:

brush sz 0 | Retrain the classifier so that it can differentiate three different classes:

blending: transhcent

e Small round objects
color mo

contour: = ¢ e Large round objects

n edt dn = o Large elongated objects

https://github.com/BiAPoL/Bio-
image Analysis_with Python/blob/main/09 machine learning/interactive object classification

YW @haesleinhuepf June 2023  /readme.md



https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_object_classification/readme.md
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_object_classification/readme.md
https://github.com/BiAPoL/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/interactive_object_classification/readme.md

Machine learning using Python
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e Use scikit-learn and apoc in Jupyter Notebooks to train and apply Random Forest Classifiers and

Support Vector Machines

[ uicense-cc-ay

Documen n « Share feedback

YW @haesleinhuepf

[} my_object_segmenter.cl
> images

D .DS_Store

D .gitignore

[ ucENSE-CC-BY

on » Share feedback

v = [m] X
) Bio-image_Analysis_with_Python X | 4
&« > C @ qgithub.com/BiAPol/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/01_supervised_machine_learning.ipynb = i N | o s
ED Code Bio-image_Analysis_with_Python / 09_machine_learning / 01_supervised_machine_learning.ipynb T Top
| Previ Code | Bl 725 Lines (725 loc) - 145 KB - ) E——
P main . +la review ode Sy 75 lines (72 ) 3 ) Bio-image_Analysis_with_Pythan X |+
Q6 f e 8 4 & = @ @ github.com/BiAPol/Bio-image_Analysis_with_Python/blob/main/09_machine_leamning/02_scikit_learn_random_forest_pixel_classifieripynb [EANT I «d » 0O o :
Go to file i
L apucpiy N g ". EB Code Bio-image_Analysis_with_Python / 09_machine_learing / 02_scikit_learn_random_forest_pixel_classifier.ipynb T Top
=
[ apocT.png S 61 - L L - A4 = =] X
5 | Preview | Code  Blame 61 ia-i s wit
o S £ main - + ) Bic-image_Analysis with Pythor X |
apoc8.png 1] — = -
o . ad Qs . n edt dm: - &« - C & github.com/BiAPol/Bio-image_Analysis_with_Python/blob/main/09_machine_learning/03_apoc_object_segmenter.ipynb e & % 0O o H
apoc9.png Go to file contiguous:
D apoc_object_segmentation.mp4 L apuLupy EH Code Bio-image_Analysis_with_Python / 09_machine_learning / 03_apoc_object_segmenteripynb T Top
2
dme.md O apoc7pn
0 resamen pecteng ) o Code | Blame 346 lines (346 loc) - 237 KB Rw (D& 2 -
[ 01_supervised_machine_leamin... O apecgpng F main
o
[ 02_scikit_learn_random _forest ... {‘) 2‘ A é O apecapng Q Go to file 50
[ 03_apoc_object_segmenter.ipynb areg [ apec_object_segmentation.mp4 L apocepny
[} Machine_Learning_for_Biclmag... [3 readme.md D apoc7.png 100
(] data_generator.py EXErClSe O 01_supervized_machine_learnin... D apocB.png
[ my_object_classifier.cl Train a Support Vector Machine and visualize its [ 02_scikit_learn_random _forest_... [ apoca.png 150
0 my_object_segmenter.cl (] 03_apoc_object_segmenter.ipynb (] apoc_object_segmentation.mp4
from sklearn.sum import SVC
> images D Machine_Learning_for_Biolmag... B readme.md
lassifier = SVC _ . .
O Ds_store cressITer & (] data_generator.py ExerCIse (] 01_supervised_machine_learnin... 200
] .gitignore (] my_object_classifier.cl Change the code s [ 02_scikit_learn_random_forest_...
[ LICENSE-CC-BY ] my_object_segmenter.cl o Nudei (] 03_apoc_object_segmenter.ipynb 250
- > images + Background [ Machine_Learning_for_Biolmag...
n + Share feedback
[ .Ds_Stare * The edges bet (] data_generator.py
Exercise
B .gitignore [3 my_object_classifier.cl

Use the graphical user interface of napari and change blobs_label annotation.tif so thatthe classifier trained here
differentiates two classes: Round and elongated objects.

Optional: Use the graphical user interface of APOC.

June 2023

https://github.com/BiAPolL/Bio-

image Analysis with Python/blob/main/09 machine learning/
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Machine learning for image analysis =) Pol
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* In classical machine learning, we typically select features for training our classifier
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T ¥

Convolutions

YW @haesleinhuepf June 2023

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038

Outlook: Deep learning for image analysis

* In deep learning, this selection becomes part of the black box

Convolutional neural networks

W @haesleinhuepf June 2023

2 Pol

Physics of Life
TU Dresden

Image data source: BBBC038v1, available from the Broad Bioimage Benchmark Collection (Caicedo et al., Nature Methods, 2019].


https://bbbc.broadinstitute.org/BBBC038

summary

Today, you learned

* Machine learning for Pixel and Object segmentation

e Python
 Scikit-learn / napari

* Accelerated pixel and object classifiers (APOC)

YW @haesleinhuepf

June 2023

Coming up next:

PolL
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* Unsupervised machine learning

* Deep learning
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